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1 Summary 
LimitState:FIX is a straightforward yet robust tool for fixing STL mesh files before passing to other software (e.g. 
as preparation for 3D printing). The main functions performed by LimitState:FIX are as follows: 

1.1 Check models 

LimitState:FIX will automatically check models for errors on opening. If errors exist, a number of visual cues will 
be given to the user: 

 A red warning panel displaying the text “Solid contains errors” will be shown in the Status Bar. 

 Errors will be highlighted on the model. 

 The relevant fix functionality will become active in the Ribbon bar. 

 The number of each type of error will be displayed in red text the Errors pane. 

If the model does not contain errors, no visual cues will be provided in the viewer and the fix functionality will 
not be active.  

1.2 Close solids 

Many tools rely on a solid being topologically closed, or work more reliably with topologically closed solids. This 
is usually because a topologically closed solid has a well-defined inside and outside whereas with open solids it 
is impossible to tell definitively whether a point is inside or outside the solid. 

Capping a solid is a very complex operation and can involve many sub-operations. As part of the closing 
process, other geometric problems are fixed. For example, duplicate geometry is removed and shells that are 
inside-out or orientated inconsistently with their neighbours are reversed. 

The capping process can potentially fill quite large holes in a solid, so the quality of the results depends largely 
on the quality of the input. If an open solid already looks like a closed solid prior to closing, the chances are that 
minimal changes will be made to the geometry to close it and that visually there will be almost no change. If 
there are big gaps, it is more difficult to close the solid and LimitState:FIX might have to make some intelligent 
guesses as to what is required. 

1.3 Fix mesh orientation 

By convention the vertices of polygons in a 3D mesh should be ordered in an anticlockwise sense as viewed 
from the outside of a solid. Many mesh processing tools rely on this ordering to produce the correct results. 
LimitState:FIX will systematically identify and fix polygons in a mesh that are incorrectly oriented. 

1.4 Remove intersects 

Many tools rely on the geometry of a solid being non-self-intersecting, or work better when this is the case. 
LimitState:FIX will query whether a solid is self-intersecting, get information about self-intersections and fix 
them. 
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Self-intersection fixing can be a very complex process. It involves a large number of different techniques some 
of which may modify the original geometry. The final geometry will be as close as possible to the original 
geometry but may have undergone minor changes (typically invisible to the naked eye when viewing the 
complete solid).In very rare circumstances, LimitState:FIX may fail to fix all of the self-intersections in a solid. If 
this happens the user will be notified. This is slightly more likely to occur for open solids, as LimitState:FIX is 
unable to eliminate those parts of the geometry that would otherwise not appear in the final result. 

1.5 Make manifold 

To define a watertight mesh, the geometry needs to be 2-manifold (i.e. exactly two faces meet at each edge).  
The existence of non-manifold geometry may indicate that the model is not manufacturable.   

LimitState:FIX can be used to repair non-manifold geometry (e.g. to remove internal faces).  In order to 
perform this operation, the solid must first be closed.   

1.6 Remove noise shells 

Solids may sometimes contain a number of shells in addition to the intended geometry. These may be an 
artefact of the software used to create the solid. A Boolean union, for example, can result in a number of very 
small void shells internal to the solid because of small and unintended gaps between the original constituent 
solids. LimitState:FIX will identify shells that are separate to the main solid and, if required, remove them from 
the file. 

1.7 Simplify the mesh 

Often solids contain many more polygons than they are required to. This leads to inefficiencies when 
manipulating the file or preparing it for e.g. 3D print. LimitState:FIX provides functionality to attempt to reduce 
the number of polygons in a solid while maintaining its shape and visual appearance. This can be achieved by 
limiting the number of polygons to be more than a set value and/or by limiting the error when comparing the 
topology of the new mesh to the previous one. 

1.8 Prepare output for 3D print tools 

Before they are saved, models may be prepared for use in a range of 3D print tools that use single precision 
tolerance and / or a fixed number of decimal places to define the vertex coordinate data. 

LimitState:FIX allows the user to truncate the fixed output file in single precision tolerance, optionally rounding 
to a set number of decimal places. As this process may introduce some small errors into the model, 
LimitState:FIX also repairs these and provides the option to make the solid manifold. 

Files may also be arranged within a build platform and output in slice format (SLC or CLI) for more rapid 
incorporation into 3D printing workflows. 
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1.9 System requirements 

Component Minimum Requirement 

Processor Intel or compatible processor (500 MHz or better) 

Operating System Windows 8 or newer 

Hard Drive Space 200 Mb 

System RAM 2 Gb 

Virtual Memory Minimum 50 Mb configured swap 

Other Software Software for viewing PDF documentation (e.g. Adobe Acrobat) 

2 What’s new in version 4.0.1? 
Version 4.0.1 of LimitState:FIX constitutes a major upgrade in capabilities. The application has been extended 
from a single file “fix and save” tool to become a powerful file fixing and preparation tool for 3D printing. For 
those wishing to quickly fix a single mesh, the original functionality is still easily accessible. However, a wide 
range of improvements have also been made: 

 Models are saved within Projects. Each project has an associated build platform (the user can choose 
from a list of built-in machine specifications or define their own) and can contain multiple models.  

 Models can be imported and fixed individually or en-masse. 

 Models can be arranged within the build platform using a variety of placement algorithms. They can 
also be snapped to the floor of the build volume in preparation for validation. 

 Models are checked for credibility of scale on import. Grow or shrink as required at any time. 

 Validate projects for potential issues before exporting for print. 

 Export as slice files (SLC or CLI) as well as meshes (STL or AMF). 

 The software kernel has been upgraded to provide even quicker and more reliable fixing actions 

 Models composed of multiple shells can be split off into individual objects. 

 A number of new hole closing algorithms have been added.  
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3 Installation and licensing 

3.1 Installing LimitState:FIX  

To Install LimitState:FIX, simply double-click the installer file and follow the on-screen instructions. 

When LimitState:FIX is started for the first time, the Welcome (licensing) dialog (Figure 1) appears: 

 

Figure 1 - LimitState:FIX welcome dialog 

3.2 Evaluating the software 

LimitState:FIX can be run in evaluation mode without the need for a license. All the functionality of the 
software can be used as normal but it is not possible to save.  To use the software in evaluation mode, click 
‘Evaluate’. 

3.3 Licensing LimitState:FIX  

To run LimitState:FIX in licensed mode you will need to obtain a license activation key. A license can be 
otained  by visiting our website:  www.limitstate.com/fix  

Alternatively, click the ‘Purchase’ button to be taken to the website directly from the welcome dialog. 

To activate the software, start the application. When the welcome dialog appears, enter your license activation 
key and click ‘License Now’. A license file will then be generated on your computer. Note that this process 
requires the software to have access to the internet. If your system has an active firewall, you may need to 
provide an exception for LimitState:FIX.  

In rare instances, users may have been sent a license file directly. To use this, click the ‘click here’ link at the 
bottom of the welcome dialog and browse to the location where the LimitState:FIX license (LIC) file is saved. 
Highlight the license file and click ‘OK’. The software will now start in licensed mode. 

In case of any licensing difficulties, please contact sales@limitstate.com.

https://www.limitstate.com/fix
mailto:sales@limitstate.com
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4 User interface 
The default LimitState:FIX screen is divided into a number of distinct areas, as shown in Figure 2: 

 

Figure 2 - LimitState:FIX User Interface 

The areas shown by default are: 

 Title bar 

 Ribbon bar (containing the Project and View tabs) 

 Project pane 

 Viewer pane 

 Errors pane 

 Properties pane 

 Output pane 

 Status bar 

A brief overview of each area is given in the following sections. More detail is provided in the rest of this 
document. 

4.1 Title bar 
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The centre of the Title bar displays the name of the software and the name of the project currently being 
worked on.  

At the right side are: 

 Minimize – Minimizes the application window. 

 Restore Down – Takes the project window from full screen to normal . 

 Close – Exits the software. 

These three functions may also be accessed via the Title bar context menu, by right clicking anywhere along the 
bar. 

4.2 Ribbon bar and icon 

The Ribbon bar is the main way to access the functionality of LimitState:FIX . It is divided into a number of icons 
and tabs: 

 File (LimitState:FIX ) icon (page 27) 

 Project (page 30) 

 View (page 39) 

At the right side are: 

 Style – A dropdown allowing the styling of the user interface to be changed. 

 Help – Opens the User Guide. 

 Minimize – Minimizes the project window 

 Restore Down – Takes the project window from full screen to normal  

 Close – Closes the current project.  

4.3 Viewer pane 

The Viewer pane displays the current view of the project. The view can be manipulated using the following 
mouse gestures. Alternatively, the View tab (page 39) provides access to more advanced viewer pane 
functionality: 

 Left click + move - Rotate the view.  

 Right click + move forward / backward – Zoom the view out and in respectively. 

 Scroll wheel up / down – Zoom the view out and in respectively. 

 Scroll wheel click + move – Pan the view. 

4.4 Project pane 
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The Project pane displays a tree of the models currently loaded into the project. Actions undertaken are 
affected by the parts chosen in the tree: 

 If the Project (top level) is chosen, actions will be performed on all models within the project. 

 If an individual model is chosen, actions will be performed on only that model. 

4.5 Errors pane 

The Errors pane lists the type and number of errors that are present in the solid and allows the user to highlight 
each individually. 

4.6 Properties pane 

The Properties pane provides core access to problem parameters and status information in a direct and 
intuitive way. This feature is discussed further on page 19. 

4.7 Output pane 

This pane is used to provide solution information and messages to the user. By default it is displayed at the 
bottom of the interface. 

4.8 Status bar 

The status bar is used to report information regarding the state of the model, including: 

 Whether the model contains errors (a red panel is displayed).  

 The memory usage. 

 The current action being undertaken and its status. 

 The magnitude of translations and rotations applied to a model being manipulated using the model 
handles. 
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5 Quickstart 
LimitState:FIX is designed to be very easy to use. The main fixing operations can be run using the software’s 
default parameters by selecting functions directly from the Project tab. This section describes how a typical fix 
is undertaken: 

5.1 Projects and models 

LimitState:FIX saves files as ‘Projects’. A project contains information about: 

 The chosen platform (3D printer). 

 The model(s) selected for fixing and / or export. 

At the simplest level, a single file that requires fixing is opened inside a project, fixed and exported. However, 
LimitState:FIX can also be used to simultaneously prepare multiple models for printing by importing, fixing and 
arranging them on an appropriately sized build plane, before exporting in slice file format.  

Both the above use cases are described here. Instructions are provided in blue text and preceded by an arrow. 
Text in bold face corresponds to a label or button in the interface, e.g: 

 Select Create project and click OK  

5.2 Use case 1 – fixing and saving a single model 

5.2.1 Create a project and import a file 

On starting LimitState:FIX , after the licensing options, the Quick Start dialog will be displayed. This provides a 
number of choices: 

 Create project – Opens a blank project for one or more models to be imported into. 

 Open project – Select an existing project. 

 Open example – LimitState:FIX is installed with a number of example files containing a variety of 
errors that can be fixed. These can be used to explore the functionality of the software. 

 Open recent – Opens a recently accessed project or file. 

 Select Create project and click OK  

The Platform Setup dialog will be displayed (Figure 3): 
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Figure 3 - LimitState:FIX Platform Setup dialog 

The Platform Setup dialog provides a choice of 3D printer environment within which the imported model(s) 
can exist. Here, we will use the Default option, as the fixed model will not be prepared specifically for printing. 
A new platform can be defined by clicking the <Add new…> option in the dropdown.  

 Select – Default – and click OK  

An empty build volume is displayed in the Viewer Pane. The face at the base of the volume is marked using 
squares (Figure 4): 

 

Figure 4 - An empty project 

A model file now needs to be imported into the project.  

 In the Model section of the Project tab, select Import 

 Browse to the required file (e.g., here we will use the Bunny.stl file available in the 
examples) and click Open  
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The file will now be loaded and displayed in the Viewer pane (e.g. see Figure 5). 

If the file contains errors, this will be reported in a number of areas on the screen (Figure 6): 

1. The Viewer pane – will highlight the different errors on the model ((you may need to rotate the view 
to see these properly). Additionally, the bounding cuboid for the model will be shown in red (a model 
without errors will have an orange bounding box and a validated model without errors will have a 
green bounding box).  

2. The Errors pane – will list the errors (and number of each) by type in red text (a fixed model will 
display no errors in black text). 

3. The Project pane – will list the name of the file with a pink icon next to it (a fixed model will be shown 
alongside a blue icon). 

4. The Status bar – will alert to the presence of errors by displaying a red warning box (a fixed model will 
have no warning). 

5. The Ribbon bar – will display fixing operations as being active (buttons become inactive for a fixed 
model). 

6. The Properties pane – will display e.g. “Is Closed = False”  

 

Figure 5 - STL file with errors opened in LimitState:FIX  
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Figure 6 - STL with errors – visual cues in LimitState:FIX  

5.2.2 Perform fixes 

If errors are present in the file, the icons for the relevant fixing operations will become active in the Auto Fix 
and Manual Fix panels of the Project tab. The user now has the option of either automatically fixing all the 
errors or manually fixing errors of a particular type: 

5.2.2.1 Auto Fix 

 

Click the Auto Fix icon to automatically fix any errors using the default parameters. This option 
will: 

 Fix all misaligned surface normals (page 34). 

 Close all solids (page 34). 

 Remove any self-intersections (page 34). 

 Remove any noise shells (page 35). 

 Make the mesh manifold (page 33). 

5.2.2.2 Manual Fix 

  

  
 

In addition to automatically fixing the entire solid, LimitState:FIX allows you to also fix errors 
one at a time. The icons for any error types that can be fixed will become active in the Manual 
Fix panel. Click any active icon to perform that repair function. 

 Fix all misaligned surface normals (page 34). 

 Close all solids (page 34). 
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 Remove any self-intersections (page 34). 

 Make the mesh manifold (page 33). 

5.2.2.3 Noise Shells 

 

Click the Remove icon to automatically remove any noise shells with a size below the set 
threshold (page 35). 

 Fix the model using either the Auto Fix function or Manual Fix options  

Once the model is completely fixed, the model will be updated and the visual cues will disappear (Figure 7): 

 

Figure 7 - STL file fixed with LimitState:FIX  

5.2.3 Set output precision (optional) 

5.2.3.1 Set Precision 

 

Depending on the intended use of the file after it may be desirable to set the precision of the 
file. To do this, select the required options from the Operations section of the Project tab and 
click the Set Precision icon. For more information on setting the output precision, see page 32. 

5.2.4 Simplify the solid (optional) 
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5.2.4.1 Simplify 

 

Once the main fixing operation(s) have been undertaken, the mesh can be re-meshed 
(simplified) by reducing the number of triangles. This can be done by allowing LimitState:FIX to 
automatically find a more efficient surface geometry while limiting the error when compared to 
the original geometry. This is achieved by directly reducing the number of triangles allowed, or 
by a combination of the two. For more information on mesh simplification, see page 31. 

5.2.5 Export the fixed file 

5.2.5.1 Export 

 

Click the Export icon and enter a file name. Files can be exported in STL, AMF, SLC or CLI file 
format. 

 Perform any optional steps as desired and Export the fixed file  

5.3 Use case 2 – fixing multiple models and preparing for print 

Here we import a number of models and fix them in preparation for printing on a specified build machine. 

5.3.1 Set the build machine and import files 

First we set up the project by defining the build machine: 

 Select Create project and click OK  

The Platform Setup dialog will be displayed (Figure 8). Selecting a particular machine in the Name dropdown 
will fill out the remaining fields with the information relating to that platform. Selecting <Add new…> will open 
a new dialog to allow the specification of a new platform (which will then be available to use in future 
projects). More about adding a new platform is given in Section 12. 

 

Figure 8 - The Platform Setup dialog 

 Name – the name of the platform to be used 

 Build Volume – the dimensions of the available build space in the x, y and z directions (mm) 

 Layer Thickness – the depth of each layer (used when preparing slice files as output) 

 Packing Margin – the space (in mm) allowed between the bounding cuboid of ach model in the 
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project) 

 Select Default from the Name dropdown and click OK  

Files now need to be imported into the project: 

 Click the Model > Import button, navigate to the examples folder and select the 
Cantilever.stl and Extinguisher.stl files to import (you can select multiple files by holding 
CTRL). Click Open. 

LimitState:FIX will now load the models into the project (note that the errors in each model are also 
determined at this time, so import may take a few seconds). If multiple models are imported at the same time, 
the Arrange models dialog will be displayed (see page 35 for more information on the Arrange functionality): 

 

 Click OK to arrange the models using a rectangular arrangement algorithm, with the 
bottom left of the platform as the starting point and with a 2mm gap (packing margin) 
between each model. 
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5.3.2 Fix the files 

Any errors in the models will be flagged in the user interface via the methods described in Figure 6. Selecting an 
individual model (either in the Project tree or in the Viewer pane) will highlight the errors associated with that 
file only in the Errors pane, Properties pane etc. 

To fix all the models simultaneously: 

 First ensure that the Project is selected (top level in the Project tree or double-click in 
blank space in the Viewer pane). You will notice that all he bounding cuboids are marked 
with dashed lines – signifying that none are selected. 

 Next, click Auto Fix. 

To fix a model individually, you can select by clicking on its name in the Project tree or double-click in the 
Viewer pane.  The available fix options for that model then become available in the Ribbon bar and can be 
used as required. 

5.3.3 Prepare for output 

Once fixed, the models can be prepared for Export. The first stage in this process is to ensure the project is in a 
valid state. Figure 9 shows the cantilever and extinguisher files post-fix: 

 

Figure 9 - Multiple fixed files in a build platform 

The orange lines of the model bounding boxes indicate that they have not yet been Validated and may lie 
outside the build domain (although the models are arranged within the domain on import, fixing can 
sometimes modify the faces enough to cause parts to then lie outside). Until the status is confirmed, the 
project cannot be exported (note that individual models can still be exported as this does not require reference 
to other models or the platform itself). 
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 Click the Operations > Validate button to validate the project. 

If the project is valid, the bounding boxes of the models will turn green (Figure 10) and the Output pane will 
indicate that the checks have been passed. If a warning is given on validation, you may select the offending 
model and click Model > Snap to return it to within the platform domain. 

 

Figure 10 - The validated project (bounding cuboids in green) 

To fix a model individually, select by clicking on its name in the Project tree or double-click in the Viewer pane.  
The available fix options for that model then become available in the Ribbon bar and can be used as required. 

5.3.4 Export as a slice file 

Once validated, the option to Export the project becomes available. Projects can be exported as STL or CLI slice 
formats, as well as STL or AMF.  

 Click the Operations > Export button to bring up the Save As dialog.  Save the file as a 
SLC. 

The slice file can then be read into any enabled third party software (Figure 11): 
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Figure 11 - The fixed and exported slice file (displayed using third party software) 

6 Project pane 
The Project pane (Figure 12) contains a tree of models within the project. 

At the top level is the name of the project (LimitState:FIX 1 in Figure 12). Selecting this entry in the tree will 
allow subsequent actions, where appropriate, to affect all the models in the project. 

 

Figure 12 - The Project tree, showing a model with errors (pink icon) and a model that has been fixed (blue 
icon) 

Under the project level are the models contained within the project. Each model is identified by its name and is 
accompanied by an icon. If the icon is pink, the model contains errors. If the icon is blue, the model has been 
fixed. Selecting an individual model will allow subsequent actions, where appropriate, to affect only this model. 

Right-clicking the model name in the tree will bring up a context menu, providing access to the following 
functions: 

6.1 Export 

Export the selected solid to one of a number of file formats (STL, AMF, SLC or CLI). If the top level of the project 
is selected, the exported file will contain all the solids within the project. 

6.2 Export individually 

Export the solids in the project as individual files (for instance, after converting a file to individual parts). Note 
that this functionality can only be used from the top level of the project tree (i.e., it cannot be used on a single 
solid). 
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6.3 Convert to parts 

Where a solid consists of multiple separate shells, this function splits it into its constituent parts, making each 
an object that can be worked on individually. As the newly created objects may then contain errors and/or 
positioning issues (overlaps etc.), the Convert to parts functionality includes Auto-fix (page 33) and Arrange 
(page 35) steps by default. If required these stages can be omitted by modifying the Project Settings (page 28). 

Note that this option is selectable for single-shell objects, but will not have any effect. 

6.4 Delete 

Removes the selected solid from the project. 

7 Properties pane 
The Properties pane (Figure 13) provides information about the Project or the selected model: 

 

 

a) b) 

Figure 13 - The LimitState:FIX Properties pane a) Project level and b) with a model selected 

7.1 Project information 

7.1.1 Dimensions 
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The dimensions of the platform in the x, y and z directions (mm). 

7.1.2 Layer Thickness 

The thickness of each layer (in mm). Used when exporting the fixed projects or models to a slice file format. 

7.1.3 Packing Margin 

The minimum allowable distance (in mm) between the bounding cuboids of objects when arranging within the 
platform. Note that this variable is also accessible from the Arrange dialog. 

7.2 Model information 

7.2.1 Mesh Info 

7.2.1.1 Name 

The name of the selected model. 

7.2.1.2 Num. Faces 

The number of faces in the mesh of the selected model. 

7.2.1.3 Num. Shells 

The number of individual shells comprising the selected model. 

7.2.1.4 Num. Vertices 

The number of mesh vertices in the selected model. 

7.2.1.5 Bad Orientation 

 False - the mesh does not contain any wrongly oriented polygons. 

 True - the mesh possesses polygons where the vertices are not ordered according to convention. This 
indicates that a repair is needed before the file can be used in other software. 

7.2.1.6 Is Closed 

 False - the mesh is not closed and it is highly likely that a repair is required before the file can be used 
in other software. 

 True - the mesh is closed. 

7.2.1.7 Has Intersects 

 False - the mesh does not contain any self-intersecting polygons. 

 True - the mesh possesses polygons which self-intersect. This indicates that a repair is needed before 
the file can be used in other software. 
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7.2.1.8 Is Manifold 

 False - the mesh contains polygons that are not manifold. A repair is likely to be required before the 
file can be used in other software. 

 True - the mesh is manifold. 

7.2.1.9 Is Convex 

 False - the mesh defines a non-convex solid object. 

 True - the mesh defines a convex solid object. 

7.2.1.10 Volume 

Reports the volume enclosed by the mesh (in mm3). 

7.2.1.11 Surface Area 

Reports the surface area of the mesh (in mm2). 

7.2.1.12 Dimensions 

Reports the x, y and z dimensions of the bounding box that encapsulates the mesh (in mm). 

7.2.2 Rendering 

7.2.2.1 Default 

 Face Colour – Sets the colour of the outer faces of the mesh polygons.  

 Transparency % – Sets the transparency of the solid (0 = solid, 100 = invisible). Note that back faces 
are not rendered when this value is greater than 0%. 

 Back Colour – Sets the colour of the inner (back) faces of the mesh polygons. 

 Render Both Sides – When true, both the outer and inner faces of the mesh are rendered. Note that 
this value is set to false if the transparency is above 0%. 

 Render Edges – When true, the edges of each polygon are displayed as a dark grey line. 

7.2.2.2 Errors 

 Highlight Errors – Toggles the display of errors in the viewer pane. 

 Self-Intersections – Sets the colour of self-intersecting solids. 

 Noise Shells – Sets the colour of noise shells. 

 Open Edges – Sets the colour of open edges. 

 Non-Manifold Edges – Sets the colour of non-manifold edges. 
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8 Errors pane 
The Errors pane (Figure 13) provides information about the errors in the mesh. 

 

Figure 14 - The LimitState:FIX Errors pane 

8.1 Errors 

The Error tree indicates the number errors detected in the solid.  The errors are grouped into the following 
categories: 

 Open edges (page 34) 

 Self-intersections (page 34) 

 Non-manifold edges (page 35) 

If any category contains errors, the corresponding heading will be shown in red. The number of errors found in 
each category is displayed in brackets. If an individual error is selected, an indicator (yellow arrow) will be 
shown in the viewer (Figure 22). To ensure computational efficiency, only the first 9,999 errors of each type are 
reported. 

9 File icon 
The File icon (LimitState:FIX logo) is available from the dropdown on the left hand side of the ribbon 
bar.  Clicking it provides access to the file options as well as a list of all the recently opened files and 
the undo functionality: 

9.1 File 

9.1.1 New 

 
Creates a blank project. 

9.1.2 Open 
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Opens an existing project (FIX) or creates a new one containing the selected mesh (STL or AMF) 
file. 

9.1.3 Save As 

 
Saves the project (FIX) in either Binary or ASCII format. 

9.1.4 Undo 

 
Undoes the last action. 

9.1.5 Redo 

 
Redoes the last undone action. 

9.1.6 About 

 
Opens the About LimitState dialog, which contains product and license information. 

9.1.7 Settings 

 

Open the LimitState:FIX settings dialog.  

General  

 Show Welcome screen – Set whether the welcome screen is displayed when the 
program is launched. 

 Max undo size – Sets the maximum number of undo/redo steps that the software 
saves in memory. 

 Arrange multiple files – When set to true, the software will prompt any import of 
multiple files to be arranged within the platform volume (such that overlaps are 
eliminated). 

Convert to Parts 

 Fix before splitting – Automatically fix a mesh before splitting it into parts. 

 Fix after splitting – Automatically fix all meshes produced by splitting. 

 Arrange after splitting – Automatically arrange all meshes produced by splitting. 
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9.1.8 Close 

 
Closes the current project. 

9.1.9 Exit 

 
Exits LimitState:FIX . 

9.1.10 Recent Documents 

A list of the most recently opened projects and files. Click a file with the mouse to open that particular file. 
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10 Project tab 
The Home tab provides all the functions needed to fix your STL file: 

10.1 File 

10.1.1 New 

 
Creates a blank project. 

10.1.2 Open 

 
Opens a new file. 

10.1.3 Close 

 
Closes the current file. 

10.1.4 Save As 

 

Saves a copy of the current file as an STL.  

After a file name has been entered, the Save Options dialog is displayed. This shares the 
functionality of the Set Precision dialog.  

If the mesh is not watertight at the time of saving, the option to round the precision of the 
geometry data to a specified number of decimal places is disabled. A warning message to this 
effect will be displayed in the information panel. This is because the rounding process requires 
the solid to be topologically closed and free of any self-intersections. 

10.2 Model 

10.2.1 Import 

 
Import a model into the project. 

10.2.2 Remove 
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Remove the selected model from the project. 

10.2.3 Export 

 

Export the selected model as a mesh (STL, AMF) or slice (SLC, CLI) file. If the project is selected 
in the project plane, then the Export Options dialog will be displayed (Figure 15), allowing the 
user to choose between exporting all objects as a single solid, or exporting each individually into 
separate files. 

 

Figure 15 - The Export Options dialog 

10.3 Operations 

10.3.1 Validate 

 

Undertakes a number of validation checks, to ensure that the Project is suitable for printing 
(requires models to be fixed before becoming active). Checks include whether any model lies 
outside the build volume and whether models are clashing within the build volume. 

10.3.2 Simplify 

 

Often solids contain many more polygons than necessary. The Simplify functionality in 
LimitState:FIX will attempt to reduce the number of polygons in a solid while maintaining its 
shape and visual appearance. Clicking this icon will bring up the Simplify dialog (Figure 16): 
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Figure 16 - Simplify Dialog 

10.3.2.1 Limit number of triangles 

Limits the number of triangles in the model to be less than or equal to the value specified in the Target number 
field.  By default, the value is set to be half the current number of triangles in the model. 

10.3.2.2 Limit error 

Limits the maximum error in the model re-meshing calculations to less than that specified in the Error field. The 
error is the distance from the original model surface of any vertex on the simplified model. The error 
calculation is conservative in that the actual maximum error will generally be significantly less than this. 

10.3.3 Set Precision 

 

Clicking the Set Precision icon will convert the models to single precision accuracy.  

 

Some solid file formats save floating point numbers in single precision only. For example, vertex 
coordinates in a binary STL file are stored in single precision. However, for accuracy during 
calculations, LimitState:FIX stores vertex positions in double precision. When these values are 
converted to single precision, i.e. when saving a file to STL, the vertex positions may move by a 
small amount. This can sometimes be large enough to create small scale self-intersections in a 
solid. 

In addition some software applications, particularly those used in 3D printing, may further 
modify the vertex positions of an imported STL by rounding the coordinates to a fixed number 
of decimal places (e.g. 4). This can have the effect of reducing the triangle count in the solid, 
introducing self-intersections that are not in the original model and creating additional noise 
shells.  

LimitState:FIX allows the user to specify the precision of the saved file - modifying the solid by 
truncating to single precision tolerance, optionally rounding to a fixed number of decimal places 
and then fixing any self-intersections in the resulting model. This usually involves making some 
very minor modifications to the solid. Once this has been done, saving in single precision format 
(such as to an STL file) should be safe and allow the model to be opened in other software 
without as much likelihood of errors being reported. Note that the solid should be topologically 
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closed and free of self-intersections. 

 

Figure 17 - Set precision dialog 

 

 

10.3.3.1 Prepare for output as… 

 ASCII STL - The solid will be prepared for saving as an ASCII STL. In this case, the vertex coordinates will 
be rounded to 6 significant figures. 

 Binary STL - This is the default setting. If checked, the software truncates the values to single precision 
as required by the binary STL format.  

10.3.3.2 Rounding 

Selecting the rounding option rounds vertex coordinates to the number of decimal places specified. As noted 
above, some software applications round coordinate data from input files and can, therefore, report errors 
caused by this rounding that do not exist in the original model. The rounding option is therefore provided in 
LimitState:FIX so that the solid can be loaded into such applications without errors being incorrectly reported.  

10.3.3.3 Make manifold 

If checked, the model will be made manifold after the other precision operations have been completed (page 
35). 

10.4 Auto Fix 

 

Automatically perform all fixing operations in order to repair the model(s) in a single step. This 
function will use the default project settings unless modifications have been made to these. In 
this case, the overridden values will apply.  

http://en.wikipedia.org/wiki/STL_(file_format)#ASCII_STL
http://en.wikipedia.org/wiki/STL_(file_format)#Binary_STL
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If a single model is selected, the fixing functions will only apply to that model. If the project level 
is selected (or no models) then all models will be fixed in sequence. 

The order of operations in an Auto Fix is as follows: 

1. Fix inverted normals 

2. Close solids 

3. Remove self-intersections 

4. Remove noise shells (default threshold of 1.0 used) 

5. Make manifold 

Note that the Auto Fix option does not pre-suppose the usage of the resulting solid file, 
including the software that it may subsequently be loaded into. Therefore, the Output Precision 
options are not applied in the Auto Fix step.  

10.5 Manual Fix 

10.5.1 Fix Normals 

 

Fix the orientation of all polygon normals such that they are ordered in an anticlockwise sense 
as viewed from the outside of the solid. 

10.5.2 Close Solids 

 

Automatically closes all solids. 

Closing a solid is a very complex operation and can involve many sub-operations. As part of the 
closing process, other geometric problems are fixed. For example, duplicate geometry is 
removed and shells that are inside-out or orientated inconsistently with their neighbours are 
reversed. 

The closing process can potentially fill quite large holes in a solid, so the quality of the results 
depends largely on the quality of the input. If an open solid already looks like a closed solid prior 
to closing, the chances are that minimal changes will be made to the geometry to close it and 
that visually there will be almost no change. If there are big gaps, it is more difficult to close the 
solid and LimitState:FIX might have to make some intelligent guesses as to what is required. 

A number of different hole closing algorithms are available for use in LimitState:FIX. More 
information on these is provided on page 37. 

10.5.3 Delete Self Intersections 

 

Query whether a solid is self-intersecting, get information about self-intersections and fix them. 

Note that, as part of the fixing process, this function may slightly modify the original geometry. 
The final geometry will be as close as possible to the original geometry but may have undergone 
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minor changes (typically invisible to the naked eye when viewing the complete solid). 

In very rare circumstances, LimitState:FIX may fail to fix all of the self-intersections in a solid. If 
this happens the user will be notified. This is slightly more likely to occur for open solids, as 
LimitState:FIX is unable to eliminate those parts of the geometry that would otherwise not 
appear in the final result. 

10.5.4 Make Manifold 

 

Repair non-manifold geometry. 

Clicking the Make Manifold button will cause LimitState:FIX to automatically fix any non-
manifold geometry. This operation can only be performed if the solid is closed.  If the solid is 
not closed, the button will be disabled.  

Making a solid manifold is a complex process and, in very rare circumstances, LimitState:FIX 
may not be able to complete the operation. If this happens the user will be notified and 
provided with the option to return to the model to its previous state. If this occurs as part of the 
Auto Fix process, the option will return the user to the state prior to the manifold operation 
taking place (i.e. other fixes will be applied). 

10.6 Noise Shells 

 

Automatically Remove undesirable shells from the model.  

Use the slider to set the size of shell that is to be removed from the solid.  The volume specified 
is interpreted as a fraction of the volume of the shell with the largest volume. All shells smaller 
than this fraction are highlighted in the viewer (default purple) and will be deleted from the 
model upon pressing the Remove button. For example, setting the value to 0.5 will remove all 
shells that are equal to or smaller than half the volume of the largest shell. 

As part of the Auto Fix process, all shells smaller than the largest are treated as noise (i.e. the 
default threshold is set to 1.0).  

10.7 Layout 

10.7.1 Snap 

 
Move the selected model vertically until it is level with the floor of the platform. 

10.7.2 Arrange 

 

Opens the Arrange models dialog (Figure 18), allowing the models to be arranged within the 
selected platform. 
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Figure 18 - The Arrange models dialog 

 Layout mode – Choose between organizing the models within the platform using either a Rectangle 
(quicker) or a Monte Carlo (more accurate) method. 

 Layout – Select the position on the platform base where the arranged models will be located in 
relation to; either the Bottom left corner, or the Centre. 

 Margin – Defines the minimum allowable distance (in mm) between models in the project. 
Measurements are based on the bounding cuboid for each model. 

 Algorithm – For a Rectangle arrangement scheme, selects the type of Skyline algorithm to use; either 
Bottom Left or Best Fit. 

 Iterations – For a Monte Carlo arrangement algorithm, specifies the maximum number of iterations to 
consider (more iterations correspond to a more accurate arrangement, but may not solve as quickly). 

 Fit – For a Monte Carlo arrangement algorithm, ensures a best fit is achieved (computation time may 
be slower as a result). 

 Rotations – Allows models to be rotated by 90 degrees if this is found to provide a more efficient 
arrangement. 

10.7.3 Scale 

 

Scale the selected model. Note that, if a model is imported that appears to be out of scale with 
the chosen platform, the Scale Solid dialog will be displayed automatically alongside a warning 
that the units appear to be incorrect (Figure 19): 
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Figure 19 - The Scale Solid dialog, highlighting a possible inconsistency in model size 

10.8 Settings 

 

Opening the Settings dialog (by clicking the Settings icon) presents the user with a number of 
configuration options.  

10.8.1.1 Noise shell threshold (%) 

When using the Auto Fix functionality this threshold value will be used to identify noise shells. Any shells 
whose volume is smaller than this percentage of the largest shell will be removed. The default value is 1%. 

10.8.1.2 Hole closing algorithm 

For holes with more than three edges, there are a number of possible ways in which the open space can be 
covered with a triangulated mesh. 

By default, LimitState:FIX will attempt to close holes using fan shaped groupings of faces (see below). This is 
generally fast and creates acceptable results in the majority of cases. However, on occasion (e.g. for very 
concave models) the process may not generate a satisfactory surface profile. In this situation, using a different 
hole closing algorithm may prove beneficial.  
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Figure 20 - Effects of different hole closing algorithms on a simple model 

A number of options are available in the drop-down menu: 

10.8.1.2.1 Fan 

This is the default option. Here the algorithm starts at one vertex on the edge of the hole and then attempts to 
create a face between this and every other vertex around the hole, apart from those already joined to it. 

10.8.1.2.2 Planar 

Here, vertices on the polygon defining the hole are projected onto a plane. The hole is then treated as a planar 
face and closed using a fan. This option is intended for use primarily on planar or near planar regions.  

10.8.1.2.3 Min Area 

Here the sum of the areas of all the triangles is minimized. The method tends to produce better results than 
‘fan’ or ‘planar’ meshing when used on significantly non-planar holes. However, the complexity of the 
algorithm means that the process of closing can be quite slow, particularly for very large holes. 

10.8.1.2.4 Smooth 

Here the triangulation tries to match up with the geometry surrounding the hole with a transition that is as 
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smooth as possible. Triangle edge lengths will approximately match edge lengths of nearby triangles. As a 
consequence, many new vertices may be created with this option. 

10.8.1.2.5 Contour 

Holes are filled by triangulations which attempt to join vertices at similar elevations in a way that best matches 
surrounding geometry. As a consequence, many new vertices may be created within holes. The direction of the 
vertical axis is estimated automatically for each hole 

10.8.1.2.6 Features 

Holes are filled by triangulations which attempt to connect features across the holes. No new vertices are 
added. 

10.8.1.2.7 Features – Smooth 

Holes are filled by triangulations which attempt to connect features across the holes and join them up in a way 
that best matches surrounding geometry. As a consequence, many new vertices may be created within holes. 

Figure 20 shows the results of closing a hole in a simple mesh. Note that the Fan and Planar closure methods 
produce similar results in this situation. 

11 View tab 
The View tab controls how the model is displayed and provides functions to copy and / or save the current 
screen: 

11.1 Projection 

11.1.1 Zoom All 

 
Zoom in to the model until it occupies the extents of the viewer pane. 

11.1.2 Orthographic 

 
Display the model using an Orthographic projection. 

11.1.3 Perspective 

 
Display the model using a 2-point graphical (Perspective) projection. 

11.1.4 View Angle 

With Orthographic or Perspective projection chosen, select any of the options to snap the camera to that view: 



LimitState:FIX User Manual 

 

40 

 
Iso(metric) 

 
Front 

 
Back 

 
Top 

 
Bottom 

 
Left 

 
Right (default)     

11.2 Highlight 

11.2.1 Errors 

 

Toggles the display of errors in the model (Figure 21). When enabled, Individual errors in the 
viewer pane can be highlighted using an arrow (Figure 22), if the associated error is selected in 
the Errors pane (page 12). This can be especially useful for cases when there appears to be no 
error highlighted, but the software reports a problem (e.g. for very small holes on the mesh).  

Errors that can be highlighted are: 

 Open Edges (by default shown in green) 

 Self-Intersections (by default shown in blue) 

 Noise Shells (by default shown in purple) 

 Non-Manifold Edges (by default shown in yellow) 

The colours of the highlight associated with each error type can be adjusted in the View > 
Settings dialog. 

 

Figure 21 - Highlighted errors in a STL model 
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Figure 22 – Selected self-intersection error highlighted with yellow arrow 

11.3 Full screen 

11.3.1 Enable 

 
Click this icon or press F11 to enter full-screen mode. To exit, press F11 or click the Exit button. 

11.4 Layout 

11.4.1 Status Bar 

Toggle the display of the Status bar. 

11.4.2 Output Window 

Toggle the display of the Output window. 

11.4.3 Properties 

Toggle the display of the Properties pane. 

11.4.4 Errors 

Toggle the display of the Error pane. 

11.4.5 Project 

Toggle the display of the Project pane. 

11.5 Image 

11.5.1 Capture 
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Copies a snapshot of the current Viewer pane image to the clipboard. 

11.5.2 Save 

 
Saves a copy of the current Viewer pane image as a PNG or BMP file. 

11.6 Configuration 

11.6.1 Settings 

 

Opens the View Settings dialog (Figure 23). From here you can modify the render colours and 
settings of the project: 

11.6.1.1 Rendering 

 Mode – Switch the rendering mode: 

o Background – Displays the background only. 

o Hidden Line – Displays the model as a wireframe using only the viewable portions 
(i.e. those that are not obstructed by another part of the object). 

o Wireframe – Displays the model as a wireframe with all edges shown - even those 

that are obstructed by part of the object or of another object.  

o Solid – Displays the model with full solid rendering [default]. 

 Show Bounds – Display the bounding box surrounding the model. 

 Show Floor – Display a grid on the floor of the model. 

 Show Axes – Display the axis glyph in the lower left corner of the viewer window.  

11.6.1.2 Background 

 Type – Sets they type of rendering for the background. This can be: 

o None (the background is plain black) 

o Plain (the Top colour is used) 

o Graduated (the background is graduated from the Top colour to the Bottom 
[default]). 

 Top – Sets the colour of the whole background (Plain) or the top of the graduation 
(Graduated). 
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 Bottom – Sets the bottom colour of the graduation (Graduated). 

 Bounding Box – Sets the colour of the bounding box surrounding the solid. 

11.6.1.3 Restore defaults 

 Click this button to restore all the settings to their original values. 

 

Figure 23 - The LimitState:FIX View > Settings dialog 

12 Adding and deleting platforms 
On starting a new project, the user is provided with a choice of platforms to use. There are a number of built-in 
machines listed. Adding or deleting a platform directly in the file is a simple task given access to a text editor. 

The platforms are stored in a JSON file (projectTypes.json) which is distributed with the software and located 
alongside the executable in the installation folder. 

Opening the file using a text editor, the format of the file can be seen (Figure 24): 

 

Figure 24 - The JSON source for defining platforms for use in LimitState:FIX  

To add a new platform in the software, select <Add new…> from the Platform dialog. You will then be able to 
specify a name and parameters for a new build platform. On clicking OK, this platform will automatically be 
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selected in the Platform dropdown. 

To add a new platform via the file, simply copy an existing entry to the top of the list and edit as appropriate. 
To delete a platform, cut the section between the opening quote mark (for the platform name) and the 
separating comma, after the corresponding closing parenthesis. Note that, if you wish to delete the last 
platform in the file, the final entry should NOT have a trailing comma. 
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